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The designer's workshop - series one
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Series one link
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Design considerations for 
the web
Workshop No 2 looks at how print 
design needs to adapt for online 
viewing.

All things typographic
Typography is discussed in this 
workshop so things like widow 
management, font licensing and 
justified text when publishing to 
the web.

Back to basics guide for 
designers new to Workiva
This workshop takes everything a 
bit slower for designers new to 
multi-channel publishing.

How to have a great 
submission
Workshop 6 goes through testing 
your IDML file, XBRL and report 
format review leading up to filing.

Introduction to the whole 
process
Workshop No 1 shows a 
demonstration of the integration 
between InDesign software and 
the Workiva platform.

Advanced workflow
Workshop No 4 is all about the run 
up to filing together with great tips. 
on last minute editing, complex 
image methods and switching from 
web to print
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Other resources for designers

https://event.on24.com/eventRegistration/EventLobbyServlet?target=reg20.jsp&referrer=https%3A%2F%2Fsandbox.wdesk.com%2F&eventid=2963641&sessionid=1&key=025D19479CFD8620C82EE6A514EF0139&regTag=2037576&V2=false&sourcepage=register


The designer's workshop - series two
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Series two link
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Justified verses range left
Workshop No 2 discusses the 
issues around using justified text 
for online viewing. Tips are shown 
when justified has to be used in the 
report.

IDML testing - plugin and 
discrepancy report
Workshop No 7 shows how to 
download and use the Workiva 
plugin in InDesign and where to 
find the discrepancy report.

Your first ICML pull
Workshop No 3 shows how to pull 
your first ICML into a blank 
InDesign document or into an 
existing one.

Last minute edits
Workshop No 8 shows what do to if 
you have major or minor edits close 
to filing time.

Managing RGB and CMYK 
colours
Workshop No 4 is for those 
designers needing to produce the 
XHTML document but also a 
document ready for print. 

All things around filing
Workshop 9 discusses everything 
around filing from a design 
perspective and what filing an 
XHTML document means for 
designers

Client review
Workshop No 5 is all about 
collaboration and review - outline 
labels, how to leave and receive 
comments, creating milestones 
and blacklining.

Extending the inline 
viewer
Workshop No 10 is about how to 
adapt the open source viewer to 
capture brand and add further 
functionality.

Doc setup - starting with 
InDesign
Workshop No 1 shows how to take 
content from an existing InDesign 
file and migrate it to the Workiva 
platform together with the styles.

Exporting XHTML for 
website usage
Workshop No 6 looks at using 
Workiva's XHTML for website usage 
and building further value. 
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Accompanying datasheet

Accompanying datasheet

Accompanying datasheet

Accompanying datasheet

Other resources for designers

https://event.on24.com/wcc/r/3538527/7177E08185AB0679D910D59554D74FF4/3430998


Document setup - 
Starting with 
InDesign
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Datasheet to support Workshop 2.1

This datasheet shows how to take content from an 
existing InDesign file and migrate it to the Workiva 
platform together with the styles.

If you want to get content and styles into the Workiva 
platform follow the steps below. Make sure all styles are 
applied in each process. After the first ICML has been 
imported into InDesign and style attributes changed, 
these changes will persist after subsequent ICML pulls.

Workiva Platform

Make sure 
styles are 

applied and 
copy the 
content

Paste into 
Word 

making sure 
styles are 

still applied

Import Word file into 
the Workiva platform 

Content and styles are 
now in the Workiva 
platform. Check all 

styles are applied and 
export via ICML

Delete the old text in 
InDesign and then 

place the ICML. Join 
text frames if 

necessary

Workiva Platform

Make content changes 
in Workiva and save as 

ICML. Replace the ICML 
in the same folder which 

is linked to InDesign

Updating the content

In the Links 
panel, where you 
see this warning 
sign, update link

Workiva 

1

2

3

4

6

7

5
The content in 
Workiva is now 

linked to the 
content in 
InDesign

Important: Avoid PDF to Word conversion 
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https://event.on24.com/eventRegistration/EventLobbyServletV2?target=reg20V2.jsp&eventid=3538527&sessionid=1&key=7177E08185AB0679D910D59554D74FF4&groupId=3177774&sourcepage=register


Your first ICML pull
DESIGNED REPORTING

This datasheet shows how to pull your 
first ICML into a blank InDesign 

document or use an existing one.

5

Workiva Platform

File>Save As>ICML

ICML is fully styled 
providing maximum 

flexibility for the 
designer

1

2

File > Place

Before you edit styles, bring 
in enough ICMLs to match 

what is in Wdesk

3
The content in Workiva is 
now linked to the content 

in InDesign

Workiva Platform

4

Paragraph
controls

Character
controls

Designers can change any 
style attribute but not the 

style name

Colour,
font family,
weight &
size

Everything 
else

5

Further ICMLs will 
not change your 

work to paragraph 
and character style 

attributes

6

ICMLs can fill one or multiple 
linked text frames

Click on the over matter sign, 
drag to create another text 

frame and release

View>Extras>Show Text Threads

+

Tip: To use/keep an 
existing InDesign 

style, replace existing 
style with your 

imported one, then 
rename the style to 
the original name 

which is in the 
Workiva platform

7
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Datasheet to support Workshop 2.3

https://event.on24.com/eventRegistration/EventLobbyServletV2?target=reg20V2.jsp&eventid=3538527&sessionid=1&key=7177E08185AB0679D910D59554D74FF4&groupId=3177774&sourcepage=register


CBA

Managing RGB 
and CMYK 
workflows 

DESIGNED REPORTING

This datasheet shows how to manage both RGB and 
CMYK workflows. This datasheet accompanies 
workshop number 4 and is for those designers needing 
to produce the XHTML document but also a document 
ready for print purposes 
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RGB is the only colour format 
supported on the web. Workiva 
uses RGB colours.

Workiva Platform

File>Save As>ICML

Pull the ICMLs from 
Workiva for the report 

content

1

2

File > Place

Place your ICML stories in single 
or multiple linked text frames

3

C. Duplicate 
image layer 

option. One layer 
is for RGB and the 

other for CMYK

44

Decision time!

B. You can export 
your RGB colours 

into another 
document and 

change them to 
CMYK

4

A. Keep to an RGB 
format for the 
duration of the 

project until print 
artwork is needed

5

Delete print/hi res 
layer when 

exporting for 
XHTML 

conversion

XHTML
creation 

from RGB

Workiva Platform

6

Save CMYK 
document/layer 
as PDF for print

or create artwork 
for printing from 

RGB

PDF

Datasheet to support Workshop 2.4

https://event.on24.com/eventRegistration/EventLobbyServletV2?target=reg20V2.jsp&eventid=3538527&sessionid=1&key=7177E08185AB0679D910D59554D74FF4&groupId=3177774&sourcepage=register


IDML testing - 
InDesign Plug-in

DESIGNED REPORTING 

Workiva Support

Go to Workiva support

here

1

If you get a warning, 
go to System 
preference>Security 
and privacy then 
Allow

2

3
Restart 

InDesign

Find the plugin at the 
bottom of the Window panel

5

4

This start/stop 
function looks 
at your ICMLs

This ungroups 
all your grouped 
items in one 
click

Keeps track of 
your ICML 
imports

Easily export 
IDML here. 
Good idea to 
Validate first

This checks your 
document against 
common errors. 
Use before IDML 
export
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Datasheet to support Workshop 2.7

This splits your 
text frames in 
one click

https://support.workiva.com/hc/en-us/articles/4404636423700-InDesign-Plug-in
https://event.on24.com/eventRegistration/EventLobbyServletV2?target=reg20V2.jsp&eventid=3538527&sessionid=1&key=7177E08185AB0679D910D59554D74FF4&groupId=3177774&sourcepage=register


Design reporting resources
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Go to the Workiva marketplace for the ESEF starter pack

The Widget
With all processes, best 
practices can help ensure a 
smooth journey. We have 
created guidelines to help 
support our users and designers 
through design reporting with 
Workiva.

Workiva community
Find help articles and 
community posts in the Workiva 
Support portal.

Workiva 
community

Quick guides for 
designers
If you're at the beginning of your 
process and looking for a quick 
guide as you get more familiar 
with Wdesk and Design 
Reporting in Wdesk, start here 
with our Quick Start Guides!

Design Matters - Series 
1-1
Here we explore getting the job 
done from the people who 
actually have done it – 266 pages 
full of graphs, maps, images and 
tables. See how it is done the 
Workiva way together with 
AngloAmerican and their design 
agency SalterBaxter!

English
French
German
Italian
Spanish
Swedish

Fonts
Supported fonts

Workiva has numerous ways to 
customize documents to suit 
your needs, allowing you to meet 
the standards and guidelines of 
your company. Among these is 
the ability to use different fonts.

Find available fonts here

InDesign Plug-in

The Workiva Integration Plug-in 
(InDesign Plug-in) is a tool that 
can be used to help InDesign 
users prepare to bring back 
content back into Workiva. 
When bringing content back into 
Workiva, it will be converted 
from IDML to XHTML. Full 
details here.

https://marketplace.workiva.com/en-us/templates/esef-annual-reporting-starter-pack
https://support.workiva.com/hc/en-us/community/posts/360073301532-Design-Reporting-Guidelines
https://support.workiva.com/hc/en-us/community/topics
https://support.workiva.com/hc/en-us/community/posts/360077307272-Design-Reporting-Quick-Start-Guides-Multiple-Languages-
https://support.workiva.com/hc/en-us/community/posts/360077307272-Design-Reporting-Quick-Start-Guides-Multiple-Languages-
https://www.workiva.com/uk/resources/creating-great-annual-report-anglo-american-salterbaxters-collaborative-workiva-journey
https://www.workiva.com/uk/resources/creating-great-annual-report-anglo-american-salterbaxters-collaborative-workiva-journey
https://support.workiva.com/hc/en-us/articles/360035640072-Supported-fonts
https://support.workiva.com/hc/en-us/articles/360035640072-Supported-fonts
https://support.workiva.com/hc/en-us/articles/360035640072-Supported-fonts
https://support.workiva.com/hc/en-us/articles/4404636423700-InDesign-Plug-in#:~:text=The%20Workiva%20Integration%20Plug%2Din,converted%20from%20IDML%20to%20XHTML.


Production Cheat 
Sheet
IDML>XHTML

DESIGNED REPORTING

Step 1:
Make copy of document. This is a disruptive 
process.

Step 2:
Unlink all ICMLs.

Step 3:
Split all linked text frames with either the Split 
story script built into InDesign or the feature on 
the integration tool.

Step 4:
If you haven't created a package, do so now. 
You only need the IDML and the fonts. This will 
become your master export folder.

Step 5:
If you are using fonts not on the Wdesk 
platform, you will now need to package your 
IDML and your font package into a single zip file.

Step 6:
Upload this zip file using the Create button in 
Wdesk to convert IDML to XHTML. 

NB: You only have to create the package once 
as subsequent IDMLs can be saved to that 
folder.

Please try to make sure you validate your 
document using the InDesign Integration tool.
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This cheat sheet assumes that below 
is already done:

• All bitmap images 
are .png, .jpg, .gif, are 72 or 
144 dpi, RGB, and are cropped 
to the containing frame. 

• All vector graphics are SVG 
format and exported from 
Illustrator with outlines and use 
RGB colours.

• All assets are to be embedded in 
the InDesign document.

• Make sure all styles are web 
compliant and not contained in 
folders.

• Make sure you only use one level 
of master page. Multiple master 
pages can be used but must be 
styled in a compliant way.

• Make sure all colour swatches 
are RBG.

• Do not rename fonts from their 
original.

• Make sure your client has the 
web usage rights to any fonts 
they are using. If they are using 
fonts in the Workiva platform, 
they are covered.

• If you are using grep styles, 
make sure the regular 
expressions are applied via the 
find and replace function before 
you do your conversion. This will 
depend on what the grep styles 
are trying to do.

All information, content, and materials available in this 
document are for general informational purposes only. 
The content on this posting is provided "as is;" no 
representations are made that the content is error-
free or up to date. Designers should test their design in 
XHTML often and keep back up files at all times.



Production Cheat 
Sheet
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• All Workiva graphs will be 
exported via ICML. They will 
be named the same as the 
section name where they 
exist in Workiva followed 
by .svg. 

• Export the ICML section 
containing the graph.

• Place the SVG into InDesign 
like you would place an 
image.

• Designers can add extra 
lines or shapes on top of the 
linked graph to enhance look 
and feel if desired.

• Chart content cannot be 
changed in InDesign. 
Changes must be made in 
Workiva.

 Tables

• Due to the limitations of ICML, table width 
and height cannot be changed in 
InDesign. Therefore, make sure these are 
set correctly in the Workiva platform.

• Margins and gutters should be the same 
in Workiva and InDesign before you start 
document setup.

• Workiva exports one table style.

• The design of content within table cells is 
controlled by Paragraph, Character and 
Cell styles

• Workiva does not have cell styles. Cell 
styles are created based on the look and 
feel in Workiva and exported via ICML.

• To style a table uniquely, isolate the table 
in the Workiva platform and add 
something unique like a light tint 
background. This will create a unique set 
of editable cell styles in InDesign.

• Ignore coloured brackets - these do not 
hinder design. These are placeholders for 
the XBRL tags.

• Row heights of tables can differ between 
InDesign and XHTML. Please use the 
NoRule style to control the padding top 
and bottom of all cells globally and adjust 
individual cell styles to be more specific.

Graphs
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Contact and help

Your primary contact for platform questions is your Customer Success 
Manager

For design queries, please contact 
design-support@workiva.com



All information, content, and materials available in this 
document are for general informational purposes only. 
The content on this posting is provided "as is;" no 
representations are made that the content is error-free or 
up to date. Designers should test their design in XHTML 
often and keep back up files at all times.
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